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BEA WebLogic Integration
Release Notes

BEA WebLogic Integration Release 2.1
Date: October 2001

Revised: January 31, 2002

Change History

The following table lists the changes included in BEA WebLogic Integration 2.1 since 
the initial release.

Date Summary of Changes

January 31, 2002 n Added support for Linux for S/390 and zSeries and DB2. For details, see “Platform 
Support” on page 6 and “Hardware and Software Requirements” on page 7. For 
installation instructions, see Appendix A, “Installing WebLogic Integration on AIX or 
Linux for S/390 and zSeries.”

December 7, 2001 n Added support for AIX and DB2. For details, see “Platform Support” and “Hardware 
and Software Requirements.” For installation instructions, see Chapter A, “Installing 
WebLogic Integration on AIX or Linux for S/390 and zSeries.”
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November 30, 2001 n Revised "Deploying EJBs and Java Classes for Business Operations" in Chapter 3, 
"Customizing WebLogic Integration," in Starting, Stopping, and Customizing BEA 
WebLogic Integration. The revised chapter includes information on how to deploy an 
EJB by manually editing the config.xml file based on CR061478, CR061980 and 
CR062010. The revised document can be found at the following URL: 

http://edocs.bea.com/wlintegration/v2_1/config/custom.htm 

n Revised Migrating to BEA WebLogic Integration Release 2.1 to include additional 
migration information (instructions on running the migration tool on UNIX systems, 
information on running migration scripts, and information concerning environment 
requirements for migration) based on CR061583, CR061557, and CR061589. The 
revised document can be found at the following URL:

http://edocs.bea.com/wlintegration/v2_1/migrate/index.htm

n Revised Chapter 4, “Tuning Performance,” in Deploying BEA WebLogic Integration 
Solutions to include additional information on tuning the performance of your 
WebLogic Integration deployment. The updated chapter can be found at the following 
URL:

http://edocs.bea.com/wlintegration/v2_1/deploy/tune.htm

November 2, 2001 n Updated the description of the EDI sample contained in Using EDI with WebLogic 
Integration to make the map name and service name consistent throughout the 
procedure, as described in CR060957 and CR060961. The updated sample can be 
found at the following URL:

http://edocs.bea.com/wlintegration/v2_1/edi/sample.htm

n Added Appendix B, “WebLogic Integration Commands,” to Starting, Stopping, and 
Customizing BEA WebLogic Integration. This appendix provides developers and 
system administrators with a reference for key WebLogic Integration commands, and 
can be found at the following URL:

http://edocs.bea.com/wlintegration/v2_1/config/keycmd.htm

October 2001 Initial Release

Date Summary of Changes
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Release Note Topics
Release Note Topics

This document includes the following topics:

n About This BEA WebLogic Integration Release

n What Is New and Improved in This Release

n Platform Support

n System Requirements

n Usage Notes

n Using the Online Documentation

n Known Limitations

n BEA Developer Center

n Contacting BEA Customer Support

For updated release note information, go to the BEA documentation Web site at the 
following URL:

http://edocs.bea.com

About This BEA WebLogic Integration 
Release

WebLogic Integration 2.1 is a single, unified platform that provides the functionality 
needed to integrate business systems within an enterprise, and to link those systems in 
a collaborative arrangement with an organization’s trading partners.
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Underlying this functionality is the industry-leading J2EE application server, BEA 
WebLogic Server, which provides the critical infrastructure needed to develop 
integrated solutions that support transaction management, security, fault tolerance, 
persistence, and clustering.

WebLogic Integration 2.1 supports end-to-end business integration by providing 
functionality in the following areas:

n Business process management makes possible the development of complex 
e-business processes that integrate existing enterprise systems, cross-enterprise 
applications, and human decision makers.

n Application integration makes it possible to integrate existing enterprise 
applications with each other, and with new e-business applications. 

n B2B integration makes possible the connection of trading partners over the 
Internet, and the integration of EDI environments with WebLogic Integration 
2.1.

n Data integration supports the seamless exchange of various data formats 
between applications and between trading partners over the Internet.

What Is New and Improved in This Release

WebLogic Integration 2.1 delivers the following new functionality and enhancements:

n Support for BEA WebLogic Server 6.1 with Service Pack 1.

n Support for EDI integration through Power.Enterprise!. The EDI integration 
functionality includes EDI message handling and processing, and value added 
network (VAN) connectivity. EDI integration connects EDI environments with 
WebLogic Integration 2.1, making it possible to integrate XML-based 
transactions with EDI-based ones.

n Internationalization support for multibyte data representations.
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What Is New and Improved in This Release
n Enhanced user experience through a number of product and documentation 
improvements:

l Smaller download image, making it easier to download and install WebLogic 
Integration 2.1. Configuration procedures have also been simplified.

l End-to-end integration sample that demonstrates how an integration solution 
is architected and developed using WebLogic Integration 2.1.

l Comprehensive product library of documentation that describes and explains 
how to use the functionality provided by WebLogic Integration 2.1.

l New documents that help you take full advantage of WebLogic Integration to 
solve your company’s challenges:

Designing BEA WebLogic Integration Solutions 

Deploying BEA WebLogic Integration Solutions 

These documents explain how to design integrated solutions following best 
practices, and how to move an integrated solution from a development to a 
production environment. 

n Enhanced XML editing functionality that supports the creation of XML 
documents from XML schemas.

n WebLogic Integration repository can be integrated with Contivo Analyst to 
perform the following functions:

l Import DTDs and XML schemas directly from the repository

l Export interfaces as XML schemas to the repository

l Save XSL stylesheets directly in the repository

n Interoperability with WebLogic Portal—WebLogic Integration now works with 
WebLogic Portal 4.0. To demonstrate this, download the instructions and 
interoperability sample for WebLogic Integration from the BEA Developer 
Center at http://developer.bea.com. You can then set up the WebLogic 
Integration interoperability sample to work with the interoperability sample 
packaged with WebLogic Portal 4.0. 
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Platform Support

WebLogic Integration 2.1 is available on the following platforms.

Note: For up-to-date information about platform support for WebLogic Integration 
2.1, see the following Web site:

http://www.bea.com/products/weblogic/integration/supported_platforms.shtml

Table 1.  WebLogic Integration 2.1 Supported Platforms

Platform Version Database

Microsoft Windows NT 4.0 with Service Pack 6 Oracle 8.1.6
Oracle 8.1.7
Cloudscape 3.5.1
SQL Server 7 SP3
SQL Server 2000
Sybase System 11.9.2 

Microsoft Windows 2000 Professional

Advanced

Oracle 8.1.6
Oracle 8.1.7
Cloudscape 3.5.1
SQL Server 7 SP3
SQL Server 2000
Sybase System 11.9.2 

Sun Solaris 7 (formerly referred to as 
2.7)

8 (formerly referred to as 
2.8)

Oracle 8.1.6
Oracle 8.1.7
SQL Server 7 SP3
SQL Server 2000
Sybase System 11.9.2 

Hewlett-Packard HP-UX 11.0 Oracle 8.1.6
Oracle 8.1.7
SQL Server 7 SP3
SQL Server 2000
Sybase System 11.9.2 

IBM AIX 4.3.3 with Performance Pack DB2 V7.2

Linux for S/390 and zSeries SuSE Linux Enterprise 
Server 7 for S/390 and 
zSeries

DB2 V7.2
6 BEA WebLogic Integration Release Notes



System Requirements
System Requirements

This section lists the hardware and software that must be installed to run WebLogic 
Integration 2.1, and it describes the databases that can be used with this product.

Hardware and Software Requirements

This section lists the hardware and software requirements for installing and running 
WebLogic Integration 2.1.

Table 2.  Hardware and Software Requirements for WebLogic Integration 2.1

Microsoft Windows NT 4.0 with Service Pack 6 or later

Microsoft Windows 2000 Professional

Microsoft Windows 2000 Advanced

WebLogic 
Server Platform

BEA WebLogic Server 6.1 with Service Pack 1

JDK JDK 1.3.1 is provided automatically on WebLogic Server; you do not need to install a Java 2 
SDK separately.

Hardware and 
Software 
Requirements

n Intel Pentium II processor or later

n 400 MHz recommended

n 100 MB free disk space

n 256-MB RAM minimum (512 MB recommended)

n Network connection

n Access to a CD reader (if installing from CD)

Databases One of the following: Cloudscape 3.5.1, Oracle 8.1.6, Oracle 8.1.7, Microsoft SQL Server 7.0 
(Service Pack 3) or 2000, or Sybase System 11.9.2. (See “Database Support” on page 10.)
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Sun Solaris 7 (formerly referred to as 2.7)
Sun Solaris 8 (formerly referred to as 2.8)

WebLogic 
Server Platform

BEA WebLogic Server 6.1 with Service Pack 1

JDK JDK 1.3.1 is provided automatically on WebLogic Server; you do not need to install a Java 2 
SDK separately.

The Solaris operating system patches for Java 2 JDK, including the Solaris OpenWindows 
Motif patches, are required if you install the software using the GUI-based installation 
procedure. The patches are available at the following URL:

http://java.sun.com/j2se/1.3/install-solaris-patches.html

Hardware and 
Software 
Requirements

n UltraSparc 5 or later

n Sparc 168 MHz or faster

n 100 MB free disk space

n 256-MB RAM minimum (512 MB recommended)

n Network connection

n Access to a CD reader (if installing from CD)

Databases One of the following: Oracle 8.1.6, Oracle 8.1.7, Microsoft SQL Server 7.0 or 2000 using 
jDriver, or Sybase System 11.9.2. (See “Database Support” on page 10.)

Table 2.  Hardware and Software Requirements for WebLogic Integration 2.1 (Continued)
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System Requirements
Hewlett-Packard HP-UX 11.0

WebLogic 
Server Platform

BEA WebLogic Server 6.1 with Service Pack 1

JDK JDK 1.3.1 is provided automatically on WebLogic Server; you do not need to install a Java 2 
SDK separately.

Hardware and 
Software 
Requirements

n HP 9000 PA RISC

n 100 MHz or higher

n 100 MB free disk space

n 256-MB RAM minimum (512 MB recommended)

n Network connection

n Access to a CD reader (if installing from CD)

For information on platform-specific configuration settings, see “Settings Required for 
Running WebLogic Integration on HP-UX 11.0” on page 13.

Databases One of the following databases: Oracle 8.1.6, Oracle 8.1.7, Microsoft SQL Server 7.0, 
Microsoft SQL Server 2000, or Sybase Server 11.9.2. (See “Database Support” on page 10.)

IBM AIX 4.3.3 with Performance Pack

WebLogic 
Server Platform

BEA WebLogic Server 6.1 with Service Pack 1

JDK JDK 1.3.0 (Classic VM with JIT enabled) is provided automatically on WebLogic Server; you 
do not need to install a Java 2 SDK separately.

Hardware and 
Software 
Requirements

n RS/6000 PowerPC-604 or higher 

n 200 MHz or faster

n 280 MB free disk space

n 256-MB RAM minimum (512 MB recommended)

n Network connection

Databases DB2 V7.2 using JDBC 2.0 driver

Table 2.  Hardware and Software Requirements for WebLogic Integration 2.1 (Continued)
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The 256-MB RAM recommendation is valid for one instance of WebLogic Server on 
which WebLogic Integration 2.1 is running. You may need more memory if you run 
two instances of WebLogic Server.

Database Support

WebLogic Integration 2.1 requires the following database-related resources:

n Access to a database server that is installed on the local network

n Database server account with privileges sufficient for creating a database with 
tables

This section describes the databases supported for use with WebLogic Integration.

Cloudscape 3.5.1 (Windows Platforms Only)

BEA ships the Cloudscape software—a pure-Java relational database management 
system (RDBMS)—with WebLogic Server. An evaluation copy of Cloudscape 3.5.1 
(no expiration) is shipped with WebLogic Server 6.1.

SuSE Linux Enterprise Server 7 for S/390 and zSeries

WebLogic 
Server Platform

BEA WebLogic Server 6.1 with Service Pack 1

JDK JDK 1.3.0 (Classic VM with JIT enabled; build cx390130-20020111 or later).

The required JDK is not included with the WebLogic Server installation. You must install the 
JDK separately. 

Hardware and 
Software 
Requirements

n S/390 or zSeries Architecture

n 280 MB free disk space

n 256-MB RAM minimum (512 MB recommended)

n Network connection

Databases DB2 V7.2 using JDBC 2.0 driver

Table 2.  Hardware and Software Requirements for WebLogic Integration 2.1 (Continued)
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System Requirements
On Microsoft Windows platforms, Cloudscape is supported for development purposes 
only. Cloudscape is not supported on Windows platforms for production 
environments.

Cloudscape is no longer supported on UNIX platforms.

If you have an older version of Cloudscape, replace it with the 3.5.1 version packaged 
with the latest WebLogic Server 6.1 distribution (full version; server with example). 
You can download WebLogic Server 6.1 Service Pack 1 from http://www.bea.com.

After you install WebLogic Server 6.1, the Cloudscape software is located in the 
following directory on Windows systems:

%WL_HOME%\samples\eval\cloudscape

In the preceding pathname, WL_HOME represents the root directory of the WebLogic 
Server installation. The Cloudscape driver consists of one file: cloudscape.jar.

Oracle 8.1.6

The Oracle 8.1.6 client libraries must be installed on a machine running WebLogic 
Server 6.1. You must also have access to an Oracle 8.1.6 server. WebLogic Integration 
uses the Oracle thin driver, which is delivered and installed with your WebLogic 
Server distribution.

For more information about configuring the Oracle thin driver supplied with 
WebLogic Server, see “Third-Party Drivers” at the following URL:

http://edocs.bea.com/wls/docs61/jdbc/thirdparty.html

Oracle 8.1.7

The Oracle 8.1.7 client libraries must be installed on a machine running WebLogic 
Server 6.1. You must also have access to an Oracle 8.1.7 server. WebLogic Integration 
uses the WebLogic jDriver for Oracle, which is provided with WebLogic Server 6.1.

For more information about configuring the WebLogic jDriver for Oracle with 
WebLogic Server, see “Third-Party Drivers” at the following URL:

http://edocs.bea.com/wls/docs61/jdbc/thirdparty.html
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Microsoft SQL Server 7.0 or 2000

Before you can use Microsoft SQL Server, you must install the WebLogic jDriver for 
Microsoft SQL Server JDBC driver (MSSQLServer4 Kit Version 7). This driver is a 
pure Java Type-4 JDBC driver that provides connectivity to the Microsoft SQL Server. 
You can download it from http://www.bea.com. Select the appropriate version of 
the driver for SQL Server version 7.0 or 2000.

The WebLogic jDriver is bundled with WebLogic Server 6.1, and is installed on your 
system when you install WebLogic Server 6.1.

A valid license entry for WebLogic jDriver for SQLServer 7.0 or 2000 is needed in 
your WebLogic Server license file.

For details about using the JDBC specification for database access, see the following 
URL:

http://edocs.bea.com/wls/docs61/jdbc/index.html

Sybase System 11.9.2

A Sybase jConnect driver is bundled with WebLogic Server. This driver is provided 
for your use without charge. If you choose to use a later version, you must make the 
appropriate changes to the config.xml file using the WebLogic Server 
Administration Console for WebLogic Server 6.1. 

DB2 V7.2 (AIX and Linux for S/390 and zSeries Platforms Only)

The DB2 V7.2 client libraries must be installed on a machine running WebLogic 
Server 6.1 SP1. You must also have access to a DB2 V7.2 server. When you install the 
DB2 V7.2 client on your machine, the JDBC 2.0 driver is also installed.

After installing WebLogic Integration 2.1, you need to specify the DB2_HOME 
environment variable in the setenv.sh file. For example:

DB2_HOME=/home/db2_inst_dir/sqllib

For more information about configuring the JDBC 2.0 driver with WebLogic Server, 
see “Using Third-Party JDBC XA Drivers with WebLogic Server” at the following 
URL:

http://edocs.bea.com/wls/docs61/jta/thirdpartytx.html
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Usage Notes
Usage Notes

This section contains the following usage information about WebLogic Integration 
components and functions:

n Running WebLogic Integration Clients on AIX and Linux

n Settings Required for Running WebLogic Integration on HP-UX 11.0

n Support for Null Variables

n Design-Time Web Application JSP Delivery Change

n Sample Email Adapter Deprecated

Running WebLogic Integration Clients on AIX and Linux

Previously, users who ran WebLogic Integration on AIX were limited to running 
Studio on AIX. This restriction, noted in the December 7, 2001 revision of these 
release notes, no longer applies. WebLogic Integration Studio and Worklist can run on 
Windows or any other supported platform, and can communicate with WebLogic 
Integration running on AIX or Linux for S/390 and zSeries.

When you use the new installer to install WebLogic Integration on AIX or Linux for 
S/390 and zSeries, any previously installed Studio or Worklist client-only installation 
must be uninstalled, then reinstalled using the new installer. 

Settings Required for Running WebLogic Integration on 
HP-UX 11.0

Changes to default configuration settings and parameters are required to run 
WebLogic Integration on an HP-UX 11.0 system.
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In WLI_HOME/setenv.sh, locate the following lines:

HP-UX) 
JAVA=$JAVA_BIN/java 
JAVAC=$JAVA_BIN/javac 
JAVA_OPTIONS="-Djava.compiler=NONE -Xms128m -Xmx512m" 
export JAVA JAVA_OPTIONS JAVAC 

Change:

JAVA_OPTIONS="-Djava.compiler=NONE -Xms128m -Xmx512m" 

to:

JAVA_OPTIONS="-hotspot -Xms256m -Xmx256m"

Also, set the max_thread_proc to 512 and max_users to 128. You must have root 
access to make this change.

Support for Null Variables

WebLogic Integration 2.1 supports null values in variables through the 
wli.bpm.server.evaluator.supportsNull option in the startWebLogic script.

When this option is set to true, all variables are initialized to a null value. When this 
option is set to false, all variables are initialized to their default values. The default 
setting for this option is false.

For details about this option, see Starting, Stopping, and Customizing BEA WebLogic 
Integration.

Design-Time Web Application JSP Delivery Change

The following information should be added to “Migrating Adapters to WebLogic 
Integration 2.1” in Developing Adapters.
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Usage Notes
The WebLogic Integration 2.1 sample adapters (eMail, DBMS, and sample) no longer 
distribute the JSP pages in a Web application archive (WAR). Rather, the JSP pages 
are precompiled into Java Servlet classes. This approach eliminates the need to 
precompile JSP pages when WebLogic Server starts. The Java Servlet classes are 
delivered in the WEB-INF\classes\jsp_servlet directory in a WAR file. Since the 
JSP pages are not bundled into the WAR file, the adapter developer needs to establish 
the mapping between a URL pattern and a specific Java Servlet class in the Web 
application descriptor WEB-INF/web.xml.

For each JSP page for your adapter, provide a Servlet declaration. For example,

<servlet>
<servlet-name>confconn</servlet-name>
<servlet-class>jsp_servlet.__confconn</servlet-class>

</servlet>

This declares a Servlet named confconn and associates it with a Java Servlet class 
jsp_servlet.__confconn. The Web application container looks for this class in the 
WEB-INF/classes directory in the WAR file. After declaring all Servlet classes, 
associate each Servlet with a URL pattern via a servlet-mapping.

<servlet-mapping>
<servlet-name>confconn</servlet-name>
<url-pattern>confconn.jsp</url-pattern>

</servlet-mapping>

This servlet-mapping associates all HTTP requests for confconn.jsp to the 
confconn Servlet in your Web application. The adapter developer must have a 
servlet-mapping for all Servlets in the Web application. See the sample adapter’s 
web.xml file for an example of all Servlet declarations and mappings needed for an 
adapter.

Sample Email Adapter Deprecated

The sample Email adapter is deprecated as of this release of WebLogic Integration. 
The sample adapter will be removed from the product in a future release.
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Using the Online Documentation

The WebLogic Integration product documentation is available from the following 
locations:

n BEA documentation Web site at the following URL:

http://edocs.bea.com

n WebLogic Integration Documentation CD, which includes HTML and Adobe 
Acrobat PDF documentation

Both locations provide Web-browsable HTML and easy-to-print Adobe Acrobat PDF 
documentation for this product.

To access the PDF files, open the BEA WebLogic Integration Home page, click the 
PDF files button, and select the document you want to view or print. If you do not have 
the Adobe Acrobat Reader, you can get it for free from the Adobe Web site at the 
following URL:

http://www.adobe.com

Recommended Platforms for the Online Documentation 
Search Applet

The Online Documentation search applet has tested well on the following platforms:

n UNIX systems running Netscape 4.x

n Microsoft Windows NT 4.0 systems running Netscape 4.x and Microsoft 
Internet Explorer 4.x and 5.x 

If you are running Microsoft Internet Explorer 5.x, you must apply the Microsoft patch 
described in “Patch Required for Microsoft Internet Explorer 5.x” on page 43.
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Known Limitations
Known Limitations

This section describes known limitations in the BEA WebLogic Integration software 
and in the search applet provided with the Online Documentation CD.

Change Requests

This section describes known limitations in WebLogic Integration, and recommended 
workarounds for them.

1 CR033753

Problem When using the WebLogic Integration Studio for instance monitoring, only tasks are 
highlighted in the graphical representation of the workflow status.

Platform All

Workaround None

2 CR036730

Problem When using the WebLogic Integration Studio, OR joins can be triggered only once, and 
they cannot be inserted in loops.

Platform All

Workaround None

3 CR037903

Problem When updating a user’s properties in the WebLogic Integration Studio, you cannot 
modify the user’s password.

Platform All

Workaround Use the WebLogic Server Administration Console to update the user’s password. See 
Starting, Stopping, and Customizing BEA WebLogic Integration for more information.
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4 CR045158 

Problem WebLogic Integration user and password information is exposed in the 
wlai.properties file. The user name and password associated with the host address 
are used by the event router to authenticate itself when posting events. This information 
is not available to the ApplicationViewDeployer when the Application View is 
deployed. The extra information is available in wlai.properties.

Platform All

Workaround None, however we recommend selecting a user name other than system.

5 CR045361 

Problem For Cloudscape, Microsoft SQL Server, Sybase, and DB2, the DBMS adapter triggers 
support only insert, update, or delete operations that affect a single row. There is no 
known workaround other than altering the code. The source code is provided in case you 
need to alter the code to get around this limitation.

Platform All

Workaround None

6 CR047116 

Problem If a JAR for an adapter is not included in the WebLogic Integration classpath, the adapter 
developer gets ClassNotFound exceptions when trying to test an event or service 
from a Web application. 

Platforms All

Workaround Include the required adapter classes in the WebLogic Integration classpath. We 
recommend adding JAR files to the end of the CMNCP environment variable in the 
SetdomainData.cmd/sh file for your domain. For example, for the wlidomain, 
there is a file called SetWlidomainData.cmd/sh. Adapter developers must include 
their JAR files in the WebLogic Integration classpath, even if they include those JAR 
files in the EAR file for the adapter.
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Known Limitations
4 CR045158 

Problem WebLogic Integration user and password information is exposed in the 
wlai.properties file. The user name and password associated with the host address 
are used by the event router to authenticate itself when posting events. This information 
is not available to the ApplicationViewDeployer when the Application View is 
deployed. The extra information is available in wlai.properties.

Platform All

Workaround None, however we recommend selecting a user name other than system.

5 CR045361 

Problem For Cloudscape, Microsoft SQL Server, Sybase, and DB2, the DBMS adapter triggers 
support only insert, update, or delete operations that affect a single row. There is no 
known workaround other than altering the code. The source code is provided in case you 
need to alter the code to get around this limitation.

Platform All

Workaround None

6 CR047116 

Problem If a JAR for an adapter is not included in the WebLogic Integration classpath, the adapter 
developer gets ClassNotFound exceptions when trying to test an event or service 
from a Web application. 

Platforms All

Workaround Include the required adapter classes in the WebLogic Integration classpath. We 
recommend adding JAR files to the end of the CMNCP environment variable in the 
SetdomainData.cmd/sh file for your domain. For example, for the wlidomain, 
there is a file called SetWlidomainData.cmd/sh. Adapter developers must include 
their JAR files in the WebLogic Integration classpath, even if they include those JAR 
files in the EAR file for the adapter.
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7 CR047229

Problem The user cannot scroll through text that is longer than the length of the text field in 
application integration plug-in event and start conditions.

Platforms All

Workaround Open the expression builder to build or view a condition for which the text is longer than 
the length of the condition text field.

8 CR048110

Problem When a data integration user tries to enter values on a tab in a binary window, the text 
being typed is not inserted at the location indicated by the cursor. This problem occurs 
when you perform the following steps:

1. Create a new format with three NULL-terminated string fields. 

2. Open the tester and click the text tab of the binary window. 

3. Right-click in this window and select generate. You will see three fields, separated 
by nonprintable block characters. 

4. Place the cursor before the N in the third field and start typing any string of 
characters. The characters you type are displayed a few characters after the N (rather 
than before the N).

Platform Windows NT and 2000

Workaround None. This bug was introduced in the JTextArea swing control with Java2 v1.3, and 
it is registered as Sun Bug ID 4398837.

9 CR048606 

Problem When the WebLogic Integration Studio is used on a UNIX system, spaces are displayed 
as special characters in application integration Plug-In View Definition dialog boxes for 
view schema definitions of event documents and service requests and responses.

Platform UNIX platforms (Solaris and HP)

Workaround None
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Known Limitations
10 CR048620 

Problem When you log in to the WebLogic Integration Studio on an AIX system, the left pane of 
the Studio window is blank.

Platform AIX platforms

Workaround From the menu bar in the Studio, choose View→Look and feel→Metal, then 

View→Look and feel→CDE/Motif. The contents of the left pane should then be 
displayed normally.

11 CR048918

Problem Login user names for the Worklist client are case-sensitive. Tasks assigned to a user may 
not be listed in a Worklist application if the user logs in to the application with a name 
spelled in a different case.

Platform All

Workaround In the Worklist application, choose View→Refresh.

12 CR049068

Problem If you shut down the B2B engine abnormally and subsequently try to use the Bulk 
Loader utility, you get an error message, indicating that the B2B engine is still running 
or was shut down abnormally.

Platforms All

Workaround Shut down the B2B engine from the WebLogic Integration B2B Console. Do not use 
Ctrl-C to shut down the B2B engine. For recommended ways to shut down the B2B 
engine, see “Monitoring B2B Integration” in Administering B2B Integration.
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13 CR050074

Problem If your application startup class is called before the B2B engine startup, the application 
startup tries to access a noninitialized instance of the B2B engine, causing an error such 
as the following: 

ERROR: Collaboration Agreement
CXMLsupplierConversation|1.1|cxml|ACSNHub|AN01000033621-T
is not yet registered in runtime. This error occurs if the
Server is not initialized properly or the
Collaboration Agreement is not registered in runtime by the
WebLogic Integration B2B Console.

Platforms All

Workaround If your application uses a startup class, you must deploy that class before deploying the 
B2B integration startup class.

14 CR050226

Problem Under the following conditions, WebLogic Integration can start the wrong workflow on 
receipt of a business message:

n The same endpoint URI is assigned for different business protocols or different 
versions of the same business protocol.

n The repository contains two collaboration agreements between the same trading 
partners.

n Those collaboration agreements define the same roles and parties, but are associated 
with different business protocols (or different versions of the same business 
protocol).

Platforms All

Workaround Assign different endpoint URIs for each business protocol (or for each version of a 
business protocol). 

For example, if one collaboration agreement references RosettaNet 1.1 and the other 
references RosettaNet 2.0 (through the trading partner delivery channels), you must 
assign one endpoint URI for RosettaNet 1.1 and another for RosettaNet 2.0.
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Known Limitations
15 CR050432

Problem In the Studio, run-time exceptions occur when variable names begin with numeric 
characters.

Platform All

Workaround Begin variable names with alphabetic characters.

16 CR051037

Problem The bulkloader command cannot be run with the initialize option. 

Platforms All

Workaround Run the createDB command to recreate the database schema.

17 CR051059

Problem You cannot update the data for parties in a collaboration agreement in the WebLogic 
Integration B2B Console.

Platforms All

Workaround If you create a party for a collaboration agreement, and subsequently want to modify any 
of the attributes associated with it (such as trading partner name, party identifier, role 
name, or delivery channel), you must delete the party, and then create a new one with the 
desired attributes.

18 CR051410

Problem Addressed message reapers can deadlock each other if sufficient connections are not 
defined in the connection pool. In the case of a deadlock, a message similar to the 
following is displayed:

Notice> <WebLogicServer> <Started WebLogic Admin Server
"myserver" for domain "bpmdomain" running in Production Mode>
java.sql.SQLException: Your transaction (process ID #8) was
deadlocked with another process and has been chosen as the
deadlock victim. Rerun your transaction. 

Platform All

Workaround Increment the number of connections defined in the connection pool.
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19 CR051469

Problem When you use a proxy server and do not set your system to bypass local addresses, you 
get the following error when running the Hello Partner sample:

ERROR> The requested URL could not be retrieved 

Platforms All

Workaround To bypass local addresses, change your Web browser configurations as follows:

n Internet Explorer:

Choose Tools→Internet Options →Connections →LAN Settings→ Bypass proxy 
server for local addresses.

n Netscape:

Choose Edit→Preferences→Advanced→Proxies→View.

Add your localhost to Exceptions.

20 CR052479

Problem The Start node properties dialog box in the Studio is not resized properly when a 
workflow triggering method is being selected. As a result, only part of the dialog box is 
displayed.

Platforms AIX platforms

Workaround Select the option for the desired triggering method two or more times. The complete 
dialog box should be displayed.

21 CR052680 

Problem When an error occurs after the command ant.cmd is issued, the system attempts to 
display an error message in a Japanese Windows environment, but Japanese characters 
are not displayed correctly. For example:

[java] ...\jsp_servlet\_addevent.java:20: ’class’ ??????
’interface’ ?????????????B 

This is a limitation of Ant and requires a fix from Apache.

Platform All

Workaround None
24 BEA WebLogic Integration Release Notes



Known Limitations
22 CR052994

Problem The WebLogic Integration software does not currently provide methods or properties for 
specifying use of the Japanese character set for sending messages and for the 
contentType of the mail header (for example, Content-Type: text/plain; 
charset="ISO-2022-JP"). 

Platform All

Workaround Email adapter code is provided with WebLogic Integration. Japanese users are free to 
alter this code to allow for the specification of character sets.

23 CR053242 

Problem The WebLogic Integration Studio does not handle time zones correctly. For example, the 
client may send a local date/time string to the server, which then parses the string in its 
own time zone. This procedure creates ambiguities when the server and client are in 
different time zones.

Rounding the date and time to the nearest day is intrinsically unsound if the system 
encompasses multiple time zones, because the date component depends on the time zone 
in which the rounding is performed. Different time zones can yield different rounded 
dates.

The following areas are affected:

n Any entity associated with a date value expressed as a string in which the time zone 
is implicit (for example, workload and statistics queries, and the effective and 
expiration dates for a template definition). 

n Any date/time value that the client rounds up or down (for example, task reroutes and 
the effective and expiration dates for a template definition).

Platform All

Workaround Formatted time values should always be expressed in GMT when sent over a network or 
stored in the database. Time values should always be displayed in local time. Calendar 
control must include the time. 
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24 CR054120 

Problem In the WebLogic Integration DBMS Adapter, update events do not properly fill in New 
elements; only Old elements are filled in. This is because the update trigger includes only 
the column data that has actually changed. The schema should indicate that all old fields 
are minOccurs=1 (required) and all new fields are minOccurs=0 (optional). The 
DbmsEventGeneratorWorker should add only elements that actually exist in the 
EVENT_DATA table (elements that were updated). 

Platform All

Workaround Alter the code in com.bea.adapter.dbms.utils.triggers.* to fix this 
problem as required.

25 CR055188

Problem Once an Oracle database account is used and a createDB operation is performed, if you 
invoke createDB again, you must drop the current username and password (using an 
Oracle script or Enterprise Manager) and then recreate the account. Otherwise, when 
attempting to bulk load data, the database returns an invalid operation error or an error 
similar to the following: 

<Aug 20, 2001 11:06:59 AM PDT> <Error> <WLC> <<BulkLoader> 
ERROR: WLC is still running or was shut down abnormally.>
ERROR: WLC is still running or was shut down abnormally.
<Aug 20, 2001 11:07:01 AM PDT> <Error> <WLC> <<BulkLoader> 
ERROR: WLC is still running or was shut down abnormally.>

This problem most often occurs when you install a new version of WebLogic Integration 
but continue to use an existing Oracle database account. This error message is also 
displayed when you invoke createDB once but repeatedly bulk load data.

Platforms All

Workaround Ensure that the server is stopped. Use the Bulk Loader -force option. 

Caution: The Bulk Loader force option should not be used if the server is running.

26 CR055321 

Problem The lightweight client API throws a null pointer exception. When a mailbox is created, 
if the isExistMailbox() method is not called, any attempt to add a message throws 
a null pointer exception.

Platform All

Workaround None
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Known Limitations
27 CR055652 

Problem The Application View connection values for initial and maximum cannot be the same 
number due to a limitation in WebLogic JCA.

Platform All

Workaround None

28 CR055751

Problem If the wlcsystem user is assigned different passwords in the config file and the 
repository, for example, if the passwords are password and wlcsystem respectively, 
then the system displays a warning, switches the user to the wlcsystem password, and 
continues operation.

Platforms All

Workaround None

29 CR055832

Problem The com.bea.wlpi.admin.Admin.getTemplate() Javadoc needs to be 
corrected and/or enhanced as follows: 

n The includeContent and parsePluginData parameters should be removed 
from the list of valid parameters. 

n The description needs to explain that if a template does not exist, then a 
WorkflowException is thrown. 

In addition, the entire BPM Javadoc set needs to better distinguish between the 
templateID and templateDefinitionID parameters.

Platform All

Workaround None
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30 CR055967 

Problem If you log off from one server and log on to another, the following JMSException is 
thrown. It appears that the topic session for the notifier is not released during logoff.

The server was unable to complete your request.

JMSException: Connection not found

Start server side stack trace: 

weblogic.jms.common.JMSException: Connection not found 

Platform All

Workaround None

31 CR056602

Problem If an MFL document is created in the data integration Format Builder with either an MFL 
or Field Codepage of Shift_JIS, the Format Tester’s translate functionality fails. 

Platform All

Workaround If possible, use MS_Kanji or EUC_JP in place of Shift_JIS. 

32 CR057621

Problem When data is being exported from the WebLogic Integration B2B Console, an SQL 
exception similar to the following may be thrown:

<Notice> <WebLogicServer> <Started WebLogic Admin Server
"myserver" for domain "mydomain" running in Development Mode>
<Sep 21, 2001 6:40:09 PM PDT> <Error> <B2B> <<Repository>
ERROR: In SQLExecutor. executeQueryWithSQLCreator, a SQL
Exception was caught while executing a SQL Statement:
java.sql.SQLException: Protocol violation> 

Platform All

Workaround In config.xml, the setting for JDBCConnectionPool should include a 
MaxCapacity setting of 80 or greater to avoid this exception while a connection is 
being established. 
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Known Limitations
33 CR057715 

Problem The BPM plug-in framework requires the X server on UNIX platforms in order to 
display GUI panels.

Platform UNIX

Workaround None

34 CR058127

Problem Japanese characters contained in RosettaNet 2.0-based business messages received by a 
trading partner are corrupted.

Platform All.

Workaround None.

35 CR058307

Problem The shutdown of a spoke which might have initiated conversations blocks if WebLogic 
Server is shutting down at the same time.

Platform All

Workaround Always explicitly shut down the B2B engine independently of WebLogic Server using 
the WebLogic Integration B2B Console. If business process management functions are 
running, shut down the process engine first using WebLogic Integration Studio. Next 
shut down the B2B engine, using the WebLogic Integration B2B Console. If shutdown 
of the B2B engine is invoked with the TERMINATE mode, an underlying WebLogic 
Server, listening for incoming requests, is required.

36 CR058732

Problem In the RosettaNet 2.0 protocol, a trading partner name cannot be specified as a string 
containing Chinese characters. A trading partner with such a name cannot exchange 
business messages.

Platform All.

Workaround None.
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37 CR058834

Problem The Test hyperlink for a service on the application view summary page for application 
views with Japanese names containing complex characters generates a 
java.lang.NullPointerException exception. This prevents you from testing 
the service from the design-time Web application. Note that the service can still be used 
from the business process management (BPM) component. 

Platform All.

Workaround None.

38 CR058949

Problem The Format Builder is unable to open palettes other than the default palette.mfl file.

Platform All

Workaround Close the Format Builder and rename the file required to be displayed in the palette to 
palette.mfl, then restart the Format Builder.

39 CR059191

Problem Several system tests result in a time out exception when they are run over a period of 
time. A message similar to the following is displayed:

<B2B-BPM-Plugin> ERROR: Cannot get variable for workflow
instance 3098 >
weblogic.transaction.internal.TimedOutException: Transaction
timed out after 93 seconds 

Platform All

Workaround None
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Known Limitations
40 CR059193

Problem There is a known issue with Microsoft SQL Server 7.0 whereby it loses the default value 
setting of database columns while copying (exporting/importing) a database. This issue 
causes the associated WebLogic Integration server, which relies on these default value 
settings, to fail. A typical error message is as follows:

java.sql.SQLException: Cannot insert the value NULL into 
column ’VALIDATED’.

Platform All

Workaround When you need to copy a Microsoft SQL Server 7.0 database, for instance, when 
migrating a WebLogic Integration database, manually ensure that the default values are 
identical with the original values. 

41 CR059332

Problem Problems have occurred when running WebLogic Integration samples on Windows 2000 
Advanced Server systems over an MSSQL 2000 database.

Platform Windows 2000 Advanced Server / MSSQL 2000

Workaround The row-locking mechanism has changed between the Microsoft SQL 7.0 and 2000 
databases. A solution is in progress and will be available in a future release.

42 CR059362

Problem Problems occur during the importing of a workflow that contains an asynchronous 
application integration service call and an asynchronous response event to capture the 
service response. Before the workflow is started, the service is removed from the 
application view. When the workflow is executed, errors occur and a 
NullPointerException is thrown. 

Platform All

Workaround None
BEA WebLogic Integration Release Notes 31



43 CR059475 

Problem Application integration plug-ins do not detect the status of a wlai-ejb-server when 
the server is down at design time. A message similar to the following is displayed:

The server was unable to complete your request. Unknown error:
NameNotFoundException:
Unable to resolve com.bea.wlpi.Admin. 
Resolved: ’com.bea.wlpi’ Unresolved:’Admin’ 

Platform All

Workaround None

44 CR059972

Problem The encoding Cp037 is no longer defined as a valid Codepage value in the data 
integration Format Builder. An exception is thrown if you try to open an MFL document 
that contains a field with the Cp037 encoding. 

Platform All

Workaround Manually change the encoding to IBM037 in the field codepage specification, as 
follows: 

Change: 

<FieldFormat name=’delim1’ type=’String’ codepage=’Cp037’ 
length=’2’/> 

To:

<FieldFormat name=’delim1’ type=’String’ codepage=’IBM037’ 
length=’2’/> 

45 CR060005

Problem After a user inactivates a trading partner in order to update it, the WebLogic Integration 
B2B Console shows it as inactive, but the following message is displayed when the 
trading partner is updated: 

<Error> <B2B> <<Admin> ERROR: Update failed because 
Trading Partner: testHub is active> 

Platform All

Workaround None
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Known Limitations
46 CR060143

Problem Invoking an undeployed application view service using the application integration 
plug-in puts the application view into an unstable state. When you invoke the 
undeployed service asynchronously, an exception similar to the following is displayed:

System error: Error in "WLAIPlugin" plugin: 
"java.lang.IllegalStateException: Async service invocation
has not been enabled for this application view. Change the
asyncEnabled attribute in the ApplicationView
Deployment Descriptor to ’true’, or use invokeService
instead."

When you invoke the undeployed service synchronously, an exception similar to the 
following is displayed:

System error: Error in "WLAIPlugin" plugin: 
"com.bea.wlai.client.ApplicationViewException: Could not
setup resources
in ApplicationView ’myAppView’".

After you deploy your application view and invoking the service again, an exception 
similar to the following is displayed:

java.rmi.RemoteException: EJB Exception: ; 
nested exception is: 
java.lang.NullPointerException 
java.lang.NullPointerException 
at 
com.bea.wlai.client.bean.ApplicationViewBean.
verifyAppViewName(
ApplicationViewBean.java:137)

Platform All

Workaround To return your application view to a stable state, test the service from the Application 
View console or restart your Weblogic Server.
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47 CR060174

Problem The MDBGenerator utility does not create deployment descriptors that correspond 
with WebLogic Server 6.1 required descriptors. It still uses elements found in WebLogic 
Server 6.0. This limitation prevents any generated MDBs from being deployed unless 
you edit the XML files by hand.

Platform All

Workaround Edit the following elements in the ejb-jar.xml file of the generated MDB file:

n jms-acknowledge-mode becomes acknowledge-mode

n jms-destination-type becomes destination-type

n run-as-specified-identity becomes run-as 

Save the file and rerun the utility to generate a deployable MDB.

48 CR060202

Problem If you create an Invoke Error Handler action in a workflow without creating an XML 
document (by leaving the editor blank), save the workflow, and then attempt to reopen 
it, an error message is displayed. The SAX parser incorrectly assumes that there is a root 
element in the document.

Platform All

Workaround Always add at least one element in the editor. Also, the invoked error handler can ignore 
the XML if desired. 

49 CR060239

Problem The XSL Transform action cannot successfully produce a nonXML result (such as 
HTML output). It is limited to producing XML documents. 

Platform All

Workaround None
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50 CR060313

Problem Uninstallation of Power.Enterprise! Server or Client software does not work if the 
uninstallation is performed from the Windows NT (or Windows 2000) Add/Remove 
Programs dialog box. The uninstallation looks for the jre on the directory from which 
the Power.Enterprise! software was initially installed. 

Platform Windows

Workaround Select the Uninstall item from the PowerIt program group on the Start menu. At the end 
of uninstallation, you may need to manually remove the installation directory.

51 CR060335

Problem WebLogic Integration fails to create an extended property for a trading partner on UNIX 
systems. An exception similar to the following is displayed:

<Oct 16, 2001 7:11:50 PM GMT-08:00> <Error> <B2B>
<<Repository> ERROR: In SQLExecutor.doUpdate, 
a SQL Exception was caught while executing a SQL 
Statement: java.sql.SQLException: ORA-01400: 
cannot insert NULL into ("BOB"."XML_NODE"."NAME")

Platform UNIX

Workaround Manually edit the exported XML file to add the extended property. For example, to add 
an extended property for the trading partner named TPSpoke:

1. From the WebLogic Integration B2B Console, choose B2B→Config→Export.

2. Select trading partner TPSpoke for export without exporting all referenced entities.

3. Edit the exported XML file to add the extended property.

4. Shut down the B2B engine from the WebLogic Integration B2B Console.

5. Import the modified XML file.

6. Restart the B2B engine.
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52 CR060401 

Problem Creating a B2B entity using the WebLogic Integration B2B Console sometimes takes 
several minutes and results in an exception similar to the following:

<Oct 17, 2001 10:58:08 AM PDT> <Error> <B2B> <<Repository>
ERROR: Error getting a Connection from the DataSource
"WLCHub.DS" in Repository Session - SQLException: WLCHub.DS>

Platform

Workaround Edit config.xml to increase the default MaxCapacity setting for the 
JDBCConnectionPool from 36 to 80.

53 CR060600

Problem The EDI adapter fails to work if WebLogic Integration is running on a DHCP machine 
and Power.Server! is running on a different machine that is configured statically or 
dynamically.

Platform All.

Workaround Either of the following workarounds correct this problem:

n Collocate both Power.Server! and WebLogic Integration on the same machine. This 
machine can have either a static IP address or be DHCP.

n If Power.Server! and WebLogic Integration are running on separate machines, the 
machine on which WebLogic Integration is running must have a static IP address.

54 CR063330

Problem When you define or edit an Application View for the DBMS Adapter from the 
Application View console, and try to add or edit an Event or Service in the Application 
View, you see a "Browse DBMS ..." link. Clicking this link causes a pop-up window to 
open and display available schemas in the database. However, you may only see a Close 
Window button, and the schema names may or may not be displayed. If this occurs, the 
DB2 driver on your platform is missing two required JDBC functions.

Platform Linux for S/390 and zSeries

Workaround Close the pop-up window and fill in the associated text field or text area with a fully 
qualified table name, SCHEMA.TABLENAME.
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Known Limitations
Enabling and Registering Collaboration Agreements

When you configure a Collaboration Agreement from the B2B Console, and select the 
Enable and register this Collaboration Agreement option on the Parties tab, the B2B 
Console may hang when you click Add/Apply. 

To avoid this problem, do the following:

1. Uncheck the Enable and register this Collaboration Agreement box, and then click 
the Add/Apply button. 

2. Select the Monitoring tab, and then click the Enable this Collaboration 
Agreement link. 

3. Select the Monitoring tab again,  (if it is not displayed), and then click the 
Register this Collaboration Agreement link.

java.net.SocketException exception on Linux for S/390 
and zSeries

This release of WebLogic Server occasionally throws the 
java.net.SocketException exception shown in Listing 1. This may occur more 
frequently in a WebLogic Integration application. 

This is a harmless defect of WebLogic Server on Linux for S/390 and zSeries. The 
exception may be ignored.

Listing 1   java.net.SocketException

####<Dec 17, 2001 8:47:09 PM CST> <Error> <HTTP> <etplx60> <myserver> 
<ExecuteThread: ’9’ for queue: ’default’> <> <> <101083> <Connection failure>
java.net.SocketException: Error in poll for fd: ’128’, revents: ’24’
at weblogic.socket.PosixSocketMuxer.deliverBadNews(PosixSocketMuxer.java(Compiled 
Code))
at weblogic.socket.PosixSocketMuxer.processSockets(PosixSocketMuxer.java(Compiled 
Code))
at weblogic.socket.SocketReaderRequest.execute(SocketReaderRequest.java(Compiled 
Code))
at weblogic.kernel.ExecuteThread.execute(ExecuteThread.java(Compiled Code))
at weblogic.kernel.ExecuteThread.run(ExecuteThread.java(Compiled Code))
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Creating a Database on UNIX Systems Using Microsoft 
SQL Server

Because Microsoft SQL Server is not supported on UNIX systems, you cannot use the 
createdb script (WLI_HOME/bin.createdb.*) to configure your Microsoft SQL 
Server 7.0 or Microsoft SQL Server 2000 database on UNIX. 

Database Limits on Strings

WebLogic Integration limits the number of characters you can include in a string for a 
B2B integration entity. If the only consideration in determining such limits were the 
need to be consistent with the repository, the limit would be 256 characters. Many 
other factors, however, must be considered: required indexing for deadlock 
prevention, data integrity and constraints, indices on multiple columns (for example, 
MessageId and DeliveryChannel), and inherent database-specific index size 
limitations. Therefore, we recommend the values listed in the following table. 

Displaying Spaces in the Studio

The WebLogic Integration Studio running on a Solaris system renders spaces as empty 
box characters. 

Limits on Length of Database Character Strings

Entity Oracle MSSQL Cloudscape Sybase DB2

TradingPartner 256 256 256 255 254

DeliveryChannel 252 128 256 128 254
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Known Limitations
Undeploying Application Integration EJB While Using 
BPM

If the wlai-ejb-server EJB is undeployed or goes down while you are using 
business process management (BPM) functionality with the application integration 
plug-in, an exception similar to the following may be thrown: 

Unknown error: NameNotFoundException: Unable to resolve 
com.bea.wlpi.Admin. Resolved: ’com.bea.wlpi’ Unresolved:’Admin’ 

If you then deploy the wlai-ejb-server EJB from the WebLogic Server Console, 
the application integration plug-in for BPM cannot detect that it has been redeployed 
and throws an exception similar to the following: 

The server was unable to complete your request. 
NoSuchObjectException: RemoteInvokable - id: ’319’ 
java.rmi.NoSuchObjectException: RemoteInvokable - id: ’319’ 

As a workaround, restart WebLogic Server after redeploying the wlai-ejb-server 
EJB. 

X Window Emulator and Telnet Connections to UNIX

The GUI-based installer for WebLogic Integration (which is written in Java) is not 
certified to run on a UNIX system reached through an X Window emulator or Telnet 
connection. Instead, we recommend a direct X Window connection. You can also use 
the console-mode installation procedure on UNIX systems without a graphics 
(windowing) workstation.

Nonpersistent Mode Recommended for B2B Integration

We recommend that you use the B2B integration functionality in nonpersistent mode. 
For details about invoking nonpersistent mode, see “Configuring Persistence and 
Recovery” in Administering B2B Integration.
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Collaboration Agreements Between Delivery Channels 
for the Same Trading Partner Not Supported

If you configure two XOCP delivery channels (one hub and one spoke) for a single 
trading partner, with a collaboration agreement between them, and you subsequently 
use the WebLogic Integration Studio to define the Start Public Workflow action for the 
workflows in the associated conversation, you get a duplicate trading partner 
error.

To work around this problem, do not set up one trading partner with two delivery 
channels. Instead, set up two trading partners, each with its own delivery channel. 
Configure a hub delivery channel for one trading partner, and a spoke delivery channel 
for the other.

Problems Viewing PIP Instance Variables

When you attempt to list the variables of certain RosettaNet PIP instances, using the 
WebLogic Integration Studio, the following error may be reported:

unknown error: ClassNotFoundException: 
com.bea.b2b.protocol.rosettanet.businessop.TemplateSysVariable

This TemplateSysVariable class is found in wlc.jar. To avoid this problem, put 
wlc.jar in the Studio classpath. This problem was previously recorded as CR054700.

Setting the Time Zone (TZ) Environment Variable for the 
JavaDate Type

On UNIX systems, the JavaDate type does not return a date with the appropriate time 
zone indicator unless the time zone variable, TZ, is set. Ensure that the TZ environment 
variable is set to the appropriate time zone.

The following example shows how to set the TZ environment variable:

TZ=US/Central
export TZ
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Known Limitations
The system administrator should set this variable before installing WebLogic 
Integration 2.1. If you experience problems with the time zone indicator on your 
system, contact your system administrator.

When the time zone environment variable is not set, the XML returned for a JavaDate 
type field is specified in Greenwich Meridian Time (GMT) as follows:

<Date>Wed Nov 15 10:55:37 GMT-06:00 2001</Date>

When the TZ variable is set to your time zone, the XML that is returned reflects your 
local time zone, as shown in the following example:

<Date>Wed Nov 15 4:55:37 CST 2001</Date>

Online Documentation Search Applet Limitations

The following sections describe the current limitations of the search applet:

n Special Characters Not Found

n Bad Magic Number Error

n UNC Pathnames Not Found

n Patch Required for Microsoft Internet Explorer 5.x

n CLASSPATH Environment Variable Error

Special Characters Not Found

The Java search applet does not currently find strings containing certain special 
characters, such as dollar signs ($), slashes(/), underscores (_), and periods (.). 
Attempts to search for strings with these special characters result in a No matches 
message.

Bad Magic Number Error

The Java Virtual Machine (JVM) used in older versions of Netscape, such as Netscape 
4.0 (1997), may have difficulty reloading the Java search applet if it was accessed 
earlier in your browser session. If this happens, you may see the following error:

Applet SearchApplet can’t start: error: java.lang.ClassFormtError: Bad magic number
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To avoid this error in Netscape 4.0, use your browser Back button to reaccess a search 
page that has already been loaded or you can upgrade to the latest Netscape version for 
your platform.

UNC Pathnames Not Found

You cannot use the search applet if you access the CD or a copy of its contents through 
a tool (such as the Windows NT Network Neighborhood) that uses Universal Naming 
Convention (UNC) paths. Such tools add a UNC path, as a prefix, to the names of 
links. When links are renamed in this way, the search applet, which uses only relative 
paths to find target HTML pages (by searching for *.htm), fails to find those pages.

If you want to use the search applet, you must access the online documentation through 
one of the following methods:

n Use the CD on a local CD reader.

n Map a network drive to a remote, shared device that contains the CD or a copy 
of the CD’s content. Then, in your browser, use the network drive to find and 
open the index.htm file in the CD’s top directory.

n Copy the CD content to a local drive on your system.

n Copy the CD content to a Web server on your corporate intranet. Make sure that 
index.htm is the default filename used by the Web server software. The top 
directory of the BEA WebLogic Integration online documentation CD contains 
an index.htm file; it creates the framework for the online documentation. If 
your Web server software does not allow you to use a file named index.htm, 
make a copy of index.htm and rename the copy with the default filename you 
must use, such as default.htm. Keep the index.htm file and the copy in the 
same directory.

This limitation resulting from the use of UNC paths affects only the search applet. You 
can use UNC path-based tools to open and navigate through the online documentation. 
The only links you cannot use in this situation are those displayed as the result of a 
search.
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Known Limitations
Patch Required for Microsoft Internet Explorer 5.x

A software bug in some versions of the Microsoft JVM used by Microsoft Internet 
Explorer versions 5.x can cause problems with applet behavior. The problem produces 
different error messages, such as Error occurred or No Matches Found. Microsoft 
has corrected the problem, and has updated the JVM for Microsoft Internet Explorer 
5.5. To correct the problem on your system, you need to download the latest build of 
the JVM from the Microsoft Web site.

To download the JVM:

1. Using your Web browser, go to the Microsoft home page at the following URL: 
http://www.microsoft.com

2. On the home page, click Downloads. The microsoft.com Download Center page 
is displayed.

3. On the microsoft.com Download Center page, do the following:

a. From the Product Name drop-down list, select Virtual Machine.

b. From the Operating System drop-down list, select your operating system.

c. Click Find It.

d. From the list of available Microsoft virtual machines, download the latest build, 
and install it on your workstation.

CLASSPATH Environment Variable Error

On some UNIX platforms, you may encounter a browser error when you open the 
Search page on the Online Documentation CD. You may, for example, receive the 
following error message:

Unable to start a java applet: Can’t find ’java40.jar’ in your CLASSPATH. 
Read the release notes and install java40.jar properly before restarting.

If the search applet does not work on your UNIX platform, try using the latest Netscape 
browser and add the path for the Netscape Java Archive (JAR) file to your CLASSPATH 
environment variable, as shown in the following example:

CLASSPATH=mytools/netscape/communicator/program/java/classes/java40.jar

As shown here, the JAR file is installed under the directory in which you installed 
Netscape.
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After modifying CLASSPATH, exit Netscape and restart it in your updated environment. 
The next time you access the Search page, the search feature should work properly.

WebLogic Integration Studio Online Help Refresh 
Limitations

Given certain settings for file types on your system when using Microsoft Internet 
Explorer as your default browser, you may encounter a limitation when refreshing 
HTML frames. This refresh limitation prevents online help pages from being displayed 
properly. For example, when you click the Help icon at the product user interface entry 
point, the initial online help splash page should be displayed. If, while navigating the 
help system, you click the Help icon again and the splash page is not reloaded as 
expected, the cause of the problem is probably this refresh limitation.

To work around this limitation, change your system file type settings by completing 
the following procedure:

1. Choose Start→Settings→Folder Options to display the Folder Options dialog box. 

Alternatively, you can double-click the My Computer icon to display the My 
Computer window. 

2. From the main menu, choose View→Folder Options to display the Folder 
Options dialog box.

3. Select the File Types tab. 

4. Using the scroll bar to the right of the Registered file types drop-down list, 
review the list of file types and select HTML Document. 

In the File type details field, the program specified in the Opens with field is 
IEXPLORE.

5. Click Edit to display the Edit File Type dialog box.

6. In the Actions list field, select Open in Same Window.

7. Click Set Default.

8. Click Close to close the Edit File Type dialog box.

9. Click Close to close the Folder Options dialog box.
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BEA Developer Center
Viewing the Studio Online Help Using Netscape 
Navigator on UNIX Platforms

To view the Online Help for individual Studio dialog boxes using Netscape Navigator 
on UNIX platforms, open the browser first. Once the browser is open, you can click 
the Help button in any dialog box or press the F1 key.

BEA Developer Center

Visit the BEA Developer Center to obtain helpful resources that you might find useful 
when creating your WebLogic Integration applications. Additional development tools, 
ideas, and programming tips are continuously added to this site, which we encourage 
you to visit often.

You can reach the BEA Developer Center at the following URL:

http://developer.bea.com/index.jsp

Contacting BEA Customer Support

If you have questions about this release of the WebLogic Integration software, if you 
encounter problems while installing and running the software, or if you need to obtain 
patches, contact the BEA Customer Support Center at the following URL:

http://www.bea.com/support

You can also contact your BEA Customer Support Center by using the contact 
information provided on the Customer Support Card, which is included in the product 
package.
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When contacting your BEA Customer Support Center, be prepared to provide the 
following information:

n Your name, e-mail address, phone number, and fax number

n Name and address of your company

n Your machine type and authorization codes

n Name and release of the product you are using

n Description of the problem and the content of pertinent error messages
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CHAPTER
A Installing WebLogic 
Integration on AIX or 
Linux for S/390 and 
zSeries

The following sections provide guidelines specific to installing and configuring 
WebLogic Integration on AIX and Linux for S/390 and zSeries platforms. Use these 
guidelines in conjunction with the detailed instructions for installing and configuring 
WebLogic Integration provided in Installing BEA WebLogic Integration and in 
Starting, Stopping, and Customizing BEA WebLogic Integration. 

n Installing WebLogic Integration in Graphics or Console Mode

n Installing WebLogic Integration Using Silent Mode

n WebLogic Integration Client Installation

n Updating the WebLogic Integration Environment

n Configuring the Database

n WebLogic Integration Commands
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A Installing WebLogic Integration on AIX or Linux for S/390 and zSeries
Installing WebLogic Integration in Graphics 
or Console Mode

Refer to the instructions provided in Installing BEA WebLogic Integration for details 
about starting and running the installation program. 

During installation, you must select a database for your samples and production 
domains. When installing on AIX or Linux for S/390 and zSeries, you must select DB2 
for both your production and samples domains.

When you select DB2, you are prompted to provide the information in the following 
table.

Note: After the installation is complete, you must specify the value for DB2_HOME in 
the setenv.sh file. For instructions, see “Updating the WebLogic Integration 
Environment” on page A-4.

Table A-1.  DB2 Database Access Information

Connection Parameter Description

Database User Account login name required to connect to the DB2 server

Database Password Password required to connect

Database Name Name used to identify the database.

Each database on the server is cataloged using a unique name. If you have set up an 
alias for the database as part of your client configuration, enter the alias. Otherwise, 
enter the unique name cataloged on the server.

For example, you would enter s_dbwli, if that alias has been assigned to the 
database using the DB2 Client Configuration Assistant, or by executing the 
following DB2 Universal Database command line processor (CLP) command:
catalog database dbwli as s_dbwli at node db2server.
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Installing WebLogic Integration Using Silent Mode
Installing WebLogic Integration Using Silent 
Mode

Be sure to review the instructions in “Using Silent Mode to Install WebLogic 
Integration” in Chapter 3, “Installing WebLogic Integration Using Console or Silent 
Mode” in Installing BEA WebLogic Integration. The following table describes the 
properties you need to specify in the installer properties file for the DB2 database.

Note: After the installation is complete, you need to specify a value for DB2_HOME in 
the setenv.sh file. For instructions, see “Updating the WebLogic Integration 
Environment” on page A-4.

Table A-2.  Sample DB2 Property Settings

DB2 Property Setting Description

SELECTED_DATABASE=“DB2” Production database. For installation on AIX or Linux for 
S/390 and zSeries, you must specify DB2.

production_db2DBName=DatabaseName

production_db2User=UserName

production_db2Password=Password

DB2 access information. Specify values for each 
parameter. Leave the other databases listed in the installer 
properties file as commented text.

For a description of these parameters, see Table A-1, 
“DB2 Database Access Information,” on page A-2.

SELECTED_DATABASE=“DB2” Samples database. If you specify Full for the 
CHOSEN_INSTALL_SET property, you must specify 
DB2 when installing on an AIX or Linux for S/390 and 
zSeries platform.

samples_db2DBName=DatabaseName

samples_db2User=UserName

samples_db2Password=Password

DB2 access information. Specify values for each 
parameter. Leave the other databases listed in the installer 
properties file as commented text.

For a description of these parameters, see Table A-1, 
“DB2 Database Access Information,” on page A-2.
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A Installing WebLogic Integration on AIX or Linux for S/390 and zSeries
WebLogic Integration Client Installation

When you are performing a client-only installation of WebLogic Integration, it is not 
necessary to install WebLogic Server 6.1 SP1 on the target system. However, after the 
installation is complete, you must copy two files, weblogic.jar and xmlx.jar, from 
the WL_HOME\lib directory on the system on which WebLogic Server is installed to 
the WLI_HOME\lib directory on the system on which you installed the client version 
of WebLogic Integration. Here, WL_HOME is the directory in which you installed 
WebLogic Server, and WLI_HOME is the directory in which you installed WebLogic 
Integration.

If you have previously performed a client only installation, you must uninstall and 
reinstall the client applications using the new installer. If you do not reinstall the client 
applications, the applications wll be unable to communicate with the the instance of 
WebLogic Integration you installed on AIX or Linux for S/390 and zSeries.

Updating the WebLogic Integration 
Environment

The environment variables used by WebLogic Integration are set by the setenv.sh 
file. This file is located in the WebLogic Integration installation directory (WLI_HOME). 
The variables in the setenv file are set when you install WebLogic Integration. You 
must update this file when using the DB2 database by setting the DB2_HOME 
environment variable to the pathname of the DB2 sqllib directory. 

To update the WebLogic Integration environment:

1. Go to the WLI_HOME directory and open setenv.sh in your preferred text editor. 
(WLI_HOME is the directory in which you installed WebLogic Integration.)
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Configuring the Database
2. Set the value of the DB2_HOME environment variable to the path name of  the DB2 
sqllib directory. For example:

DB2_HOME=/home/db2inst1/sqllib 

For additional information about the setenv command, see Appendix A, 
“WebLogic Integration Sample Configuration Files” in Starting, Stopping, and 
Customizing BEA WebLogic Integration.

3. Save your changes and close the file.

When you execute the startWeblogic command, the setenv command is invoked 
and the environment variables become effective.

Configuring the Database

Before you can start WebLogic Integration in a preconfigured domain, you must 
configure the database repository for the domain appropriately. Complete instructions 
for configuring a database using the database configuration wizard are provided in 
“Using the Database Configuration Wizard” in Chapter 3, “Customizing WebLogic 
Integration,” in Starting, Stopping, and Customizing BEA WebLogic Integration. 

The database configuration wizard provides three options: 

n Switch Database

n Create Database

n Migrate Database

For WebLogic Integration on AIX or Linux for S/390 and zSeries, however, you can 
choose only the Create Database option, which initializes the specified database. 
Because DB2 is currently the only supported database on AIX and Linux, and because 
it was not supported for earlier releases of WebLogic Integration, you cannot switch to 
another database or migrate a database from an earlier release. 
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A Installing WebLogic Integration on AIX or Linux for S/390 and zSeries
JDBC Connection Pool Parameters

Although you should use the database configuration wizard to update the database 
configuration for any of the preconfigured domains, there may be circumstances in 
which you need to update the database configuration from the WebLogic Server 
Administration Console. If you do so, you must provide the JDBC connection pool 
parameters listed in the following table.

Complete instructions are provided in “Updating the Database Configuration from the 
WebLogic Server Administration Console” in Chapter 3, “Customizing WebLogic 
Integration” in Starting, Stopping, and Customizing BEA WebLogic Integration. 

WebLogic Integration Commands

Detailed information about the WebLogic Integration commands is provided in 
Appendix B, “WebLogic Integration Commands,” in Starting, Stopping, and 
Customizing BEA WebLogic Integration.

The following table lists the commands that reference database information and the 
additional information needed for the DB2 database. 

Table A-3.  DB2 JDBC Connection Pool Parameters

Parameter Description

JDBC driver COM.ibm.db2.jdbc.app.DB2Driver

Database user Account login name required for connecting to the 
database server

Database password Password required for connecting to the database 
server

URL URL for the database. For DB2, the URL is:

jdbc:db2:database_name
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WebLogic Integration Commands
Table A-4.  DB2 Information for WebLogic Integration Commands

Command Description

createdb Creates the repository tables and loads system data.

In addition to the files listed in the command description, the following UNIX files are 
provided for DB2:

n $WLI_HOME/adapters/dbms/src/sql/CreateDB2Customer_Table.sql

n $WLI_HOME/adapters/dbms/src/sql/CreateDB2EventTables.sql 

setdbtype Sets the DB_TYPE environment variable for the domain. For DB2, this value is set to DB2.

The DB_TYPE environment variable is used in the createdb, switchdb, setdbdata, 
and RunSamples commands.
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A-8 BEA WebLogic Integration Release Notes


	Change History
	Release Note Topics
	About This BEA WebLogic Integration Release
	What Is New and Improved in This Release
	Platform Support
	System Requirements
	Hardware and Software Requirements
	Database Support

	Usage Notes
	Running WebLogic Integration Clients on AIX and Linux
	Settings Required for Running WebLogic Integration on HP-UX 11.0
	Support for Null Variables
	Design-Time Web Application JSP Delivery Change
	Sample Email Adapter Deprecated

	Using the Online Documentation
	Recommended Platforms for the Online Documentation Search Applet

	Known Limitations
	Change Requests
	Enabling and Registering Collaboration Agreements
	java.net.SocketException exception on Linux for S/390 and zSeries
	Creating a Database on UNIX Systems Using Microsoft SQL Server
	Database Limits on Strings
	Displaying Spaces in the Studio
	Undeploying Application Integration EJB While Using BPM
	X Window Emulator and Telnet Connections to UNIX
	Nonpersistent Mode Recommended for B2B Integration
	Collaboration Agreements Between Delivery Channels for the Same Trading Partner Not Supported
	Problems Viewing PIP Instance Variables
	Setting the Time Zone (TZ) Environment Variable for the JavaDate Type
	Online Documentation Search Applet Limitations
	WebLogic Integration Studio Online Help Refresh Limitations
	Viewing the Studio Online Help Using Netscape Navigator on UNIX Platforms

	BEA Developer Center
	Contacting BEA Customer Support
	A Installing WebLogic Integration on AIX or Linux for S/390 and zSeries
	Installing WebLogic Integration in Graphics or Console Mode
	Installing WebLogic Integration Using Silent Mode
	WebLogic Integration Client Installation
	Updating the WebLogic Integration Environment
	Configuring the Database
	JDBC Connection Pool Parameters

	WebLogic Integration Commands


